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Introduction  
More and more people today face the problem of smooth and cost saving system migration. It mostly has to do with 

constant hardware improvement. Traditional approach involving complete re-installation and re-setup of the operating 

ǎȅǎǘŜƳ ŀƴŘ ŀƭƭ ŀǇǇƭƛŎŀǘƛƻƴǎ ǊŜǉǳƛǊŜǎ ŀ ƭƻǘ ƻŦ ǘƛƳŜ ŀƴŘ ƭŀōƻǊ ǊŜǎƻǳǊŎŜǎΣ ŦŜǿ Ŏŀƴ ŀŦŦƻǊŘΦ aƻǊŜƻǾŜǊ ƛǘ ŘƻŜǎƴΩǘ ƎǳŀǊŀƴǘŜŜ ŀƭƭ 

software will flawlessly work on a new hardware platform. 

tŀǊŀƎƻƴ ±ƛǊǘǳŀƭƛȊŀǘƛƻƴ aŀƴŀƎŜǊϰ 2010 is an elegant solution that can help you accomplish the following tasks: 

¶ Migrate a Win2K+ physical system to a virtual environment in the online mode (P2V); 

¶ Migrate a Win2K+ physical system backed up with a Paragon disaster recovery tool to a virtual environment; 

¶ Migrate a Win2K+ virtual system to a physical environment (V2P); 

¶ Migrate from one virtual environment to another (V2V); 

¶ Migrate a Win2K+ physical system to a different hardware platform (P2P); 

¶ Connect a virtual Řƛǎƪ ŀǎ ƛŦ ƛǘΩǎ ŀƴ ƻǊŘƛƴŀǊȅ ǇƘȅǎƛŎŀƭ ŘƛǎƪΣ ǘƘǳǎ ƻǇŜƴƛƴƎ ǳǇ ŀƭƭ ŦǳƴŎǘƛƻƴŀƭƛǘȅ ŀǾŀƛƭŀōƭŜ ŦƻǊ ǇƘȅǎƛŎŀƭ 

disks to virtual (Connect VD); 

¶ Recover the startup ability after unsuccessful virtualization with a 3rd party tool; 

¶ Recover the startup ability after unsuccessful system migration to a different hardware platform. 

In this manual you will find the answers to many of the technical questions, which might arise while using the program. 

 

Our company is constantly releasing new versions and updates to its software, that's why 

images shown in this manual may be different from what you see on your screen. 

Features Overview  
This chapter dwells upon key benefits and technical highlights of the product. 

Key Features  
Let us list some of the key features: 

¶ P2V Copy to migrate a Win2K+ physical system to a virtual environment in the online mode. 

¶ P2V Restore to migrate a Win2K+ physical system backed up with a Paragon disaster recovery tool to a virtual 

environment. 

¶ Connect VD to cƻƴƴŜŎǘ ŀ ǾƛǊǘǳŀƭ Řƛǎƪ ŀǎ ƛŦ ƛǘΩǎ ŀƴ ƻǊŘƛƴŀǊȅ ǇƘȅǎƛŎŀƭ ŘƛǎƪΣ ǘƘǳǎ ƻǇŜƴƛƴƎ ǳǇ ŀƭƭ Ŧǳƴctionality available 

for physical disks to virtual. 

¶ P2V Adjust OS to recover the startup ability after unsuccessful virtualization with a 3rd party tool. 

¶ P2P Adjust OS to migrate a Win2K+ physical system to a different hardware platform. 
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¶ P2P Adjust OS to recover the startup ability after unsuccessful system migration to a different hardware 

platform. 

¶ Support for popular virtual machines - Microsoft Virtual PC, VMware Workstation, VMware Fusion, Sun 

VirtualBox. 

¶ Smart Driver Injector to make the process of adding new drivers smooth and easy. 

¶ Easy size setup for virtual disks with the partition auto-resize option. 

¶ 2 types of virtual drives for VMware to create either an IDE or a SCSI disk. 

¶ Disk file split for VMware to automatically cut the resulted virtual image to files of 2 GBs each. 

¶ Partition/Hard disk copy to successfully transfer all on-disk information including standard bootstrap code and 

other system service structures, thus maintaining the operatƛƴƎ ǎȅǎǘŜƳΩǎ ǿƻǊƪƛƴƎ ŎŀǇŀōƛƭƛǘȅΦ 

¶ File Transfer Wizard to make such operations as transferring of files/directories or burning of them to CD/DVD 

as easy and convenient as possible. 

¶ Merge Partitions Wizard to consolidate the disk space, which originally belongs to two adjacent partitions 

(NTFS, FAT16/FAT32), into a single, larger partition. 

¶ Redistribute Free Space Wizard to increase free space on one partition by up-taking the on-disk unallocated 

space and the unused space of other partitions. 

¶ Convert a file system (FAT16/32, NTFS, Ext2/Ext3) without reformatting. 

¶ Modify file system parameters (make active/inactive, hide/unhide, change serial number, partition ID, volume 

label, etc.). 

¶ Basic functions for initializing, partitioning and formatting hard disks (create, format, delete). Instead of the 

standard Windows disk tools, the program supports all popular file systems. 

¶ Undelete Partitions Wizard to recover an accidentally deleted partition. 

¶ 27 defragmentation strategies available to defragment FAT and NTFS file systems. 

¶ MFT defragmentation and shrinking to improve performance of NTFS. 

¶ Scripting to make the program create a script of any set of operations you need. Besides support of all 

operations available in the interactive mode, the unattended mode provides some additional features, such as 

conditional execution, subroutines, repeatable iterations, disk/partition properties analysis, errors 

management, etc. 

¶ Task scheduling to automate routine operations. It can be particularly effective when you have to repeat a 

sequence of actions on a regular basis. 

 
Scheduling is only available for the Windows installation of the program. 

Supported Technologies  
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Along with using innovative technologies from outside, Paragon has developed a number of its own original 

technologies that make its products unique and attractive for customers: 

¶ Paragon Hot Copyϰ technology to clone locked partitions and hard disks under Windows NT+ family operating 

systems providing both high operating efficiency as well as low hardware requirements. 

¶ tŀǊŀƎƻƴ !ŘŀǇǘƛǾŜ wŜǎǘƻǊŜϰ technology to successfully migrate a Win2K+ physical system to a different 

hardware platform (P2P). 

¶ tŀǊŀƎƻƴ tƻǿŜǊ {ƘƛŜƭŘϰ technology to provide data consistency in case of a hardware malfunction, power 

outages or an operating system failure. 

¶ tŀǊŀƎƻƴ ¦C{5ϰ technology to browse partitions of any file system including hidden and unmounted, modify 

and copy files and folders, etc. 

¶ tŀǊŀƎƻƴ Iƻǘ wŜǎƛȊŜϰ technology to enlarge NTFS partitions (system, locked) without rebooting Windows and 

interrupting its work. 

¶ tŀǊŀƎƻƴ {ƳŀǊǘ tŀǊǘƛǘƛƻƴϰ technology to securely perform hard disk partitioning operations of any complexity. 

¶ Paragon VIMϰ (Virtual Image Management) technology that enables Paragon products work with virtual disks 

as though they are physical hard disks. 

¶ Microsoft Volume Shadow Copy Service (VSS) to provide the copy/backup infrastructure for the Microsoft 

Windows XP/Vista/7/Server 2003/2008 operating systems. It offers a reliable mechanism to create consistent 

point-in-time copies of data known as shadow copies. Developed by Microsoft in close cooperation with the 

leading copy/backup solution vendors on the market, it is based on a snapshot technology concept. 

¶ Microsoft Dynamic Disk (simple, spanned, striped, mirrored, RAID-5) to offer more management flexibility 

without the partition limitation of basic disks. Dynamic storage can be particularly beneficial for large-scale 

businesses when dealing with many physical hard disks involving complex setup. 

¶ GUID Partition Table (GPT). It is the next generation of a hard disk partitioning scheme developed to lift 

restrictions of the old MBR. GPT disks are now supported by Windows Vista/7, Server 2008, Mac OS X and Linux. 

Supported Virtual Machines  
Paragon ViǊǘǳŀƭƛȊŀǘƛƻƴ aŀƴŀƎŜǊϰ 2010 provides support for major virtual machines presented on the market today: 

¶ Microsoft Virtual PC; 

¶ VMware Workstation; 

¶ VMware Fusion; 

¶ Sun VirtualBox; 

For Connect VD only 

¶ MS Windows Vista/7 backup; 

¶ Parallels Workstation; 
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¶ XenServer (.vhd only). 

System Virtualization  
With new powerful x86 computers, system virtualization has become extremely popularΦ LǘΩǎ ŀ ǎƻŦǘǿŀǊŜ ǘŜŎƘƴƻƭƻƎȅ ǘƘŀǘ 

enables to run several virtual machines on one physical machine, providing resources of that single computer are shared 

across several environments. As a result one and the same physical computer can have multiple OSs and applications 

operating simultaneously, thus opening up enormous opportunities for both, business and home users, exactly: 

¶ Avoid underutilization of up-to-date powerful computers; 

¶ Increase flexibility of a physical infrastructure; 

¶ Provide for increased availability of hardware and applications; 

¶ Cut expenses on hardware and energy; 

¶ Guarantee smooth and cost saving system migration; 

¶ Enjoy workinƎ ǿƛǘƘ ƻƭŘ ŀǇǇƭƛŎŀǘƛƻƴǎ ȅƻǳ ŎŀƴΩǘ ƭŀǳƴŎƘ ƻƴ ȅƻǳǊ ŎǳǊǊŜƴǘ t/Τ 

¶ Take advantage of having multiple operating systems on one Windows PC, including Linux, Mac OS X, etc.; 

¶ CƻǊƎŜǘ ŀōƻǳǘ ƘǳƴǘƛƴƎ ŦƻǊ ǊŜǇƭŀŎŜƳŜƴǘ ƻŦ ǘƘŜ ŦŀƛƭŜŘ ƘŀǊŘǿŀǊŜΣ ŀƴŘ Ƴŀƴȅ ƳƻǊŜΧ 

Known Issues 

1. You should install integration services (e.g. VMware Tools) on the virtual system yourself. We only guarantee its 

smooth startup. 

2. At the startup, a virtual machine (e.g. VMware Workstation) might notify you that the used virtual disks are of 

old format and require update. You can update your disks, since this procedure involves change of a version 

only, nothing else. This is done on purpose not to lose compatibility with the older versions of VMware. 

3. After transferring Microsoft Vista and later versions to a virtual disk, you will need to re-activate license of the 

ǎȅǎǘŜƳΦ LǘΩǎ ƴƻǊƳŀƭ ōŜƘŀǾƛƻǊ ŀǎ ǘƘŜǎŜ ǎȅǎǘŜƳǎ ƪŜŜǇ ǘǊŀŎƪƛƴƎ ŀƴȅ ŎƘŀƴƎŜ ƻŦ ƘŀǊŘǿŀǊŜΦ wŜ-activation is legally 

justified in this case, as you transfer your system to another PC. 

4. If you prefer to create a SCSI HDD when converting to a virtual disk of VMware Workstation or VMware ESX 

Server, we pick a driver for the HDD controller just the way VMware does, i.e. according to the found OS: 

¶ Windows 2000/Windows XP ς Buslogic; 

¶ Windows 2003 (all editions including WinXP x64) and later versions ς LSI Logic. 

Thus if you will then connect the created virtual disk to a virtual machine with another type of the adapter, the 

ǎȅǎǘŜƳ ǿƻƴΩǘ ǎǘŀǊǘ ǳǇΦ tƭŜŀǎŜ ǳǎŜ ƻǳǊ tнt !ŘƧǳǎǘ ²ƛȊŀǊŘ ǘƻ ƛƴǎǘŀƭƭ ǘƘŜ ǊŜǉǳƛǊŜŘ ŘǊƛǾŜǊΦ 

5. If you convert a partition/hard disk with Windows XP to a SCSI virtual disk of VMware Workstation or VMware 

9{·Σ ƛǘΩǎ ǊŜǉǳƛǊŜŘ ǘƻ ŀŘŘ ǘƘŜ ±aǿŀǊŜ {/{L ŘǊƛǾŜǊ ŦǊƻƳ ƻǳǘǎƛŘŜΣ ǎƛƴŎŜ ²ƛƴŘƻǿǎ ·t ŘƻŜǎƴΩǘ ƘŀǾŜ ƛǘΦ ¢ƻ Řƻ ǘƘŀǘ ǿŜ 

try to find an installed version of VMware Workstation on your computer to extract the necessary driver. If 

failed to find, we will ask you to provide a path to the VMware Tools ISO image. 
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6. We can smoothly convert a hard disk with several operating systems. But according to Issue 4, when converting 

to a SCSI virtual disk of VMware Workstation or VMware ESX Server, for different versions of OS, different 

controller drivers will be installed. VMware however cannot emulate different hardware for each operating 

system of one virtual machine. To tackle this issue, please use our P2P Adjust Wizard to install the LSI Logic 

driver under Windows 2000/Windows XP, then select the LSI SCSI controller for your virtual machine. 

Windows Components  
In the given section you can find all the information necessary to successfully work with the Windows version of the 

product. 

Interface Overview  
This chapter introduces the graphical interface of the program. The design of the interface precludes any mistake being 

made on the part of the user. Most operations are performed through the system of wizards. Buttons and menus are 

accompanied by easy understandable icons. Nevertheless, any problems that might occur while managing the program 

can be tackled by reading this very chapter. 

General Layout  

When you start the program, the first component that is displayed is called the Launcher. It enables to run wizards and 

dialogs, to specify program settings, to visualize the operating environment and the hard disk configuration. 

¢ƘŜ [ŀǳƴŎƘŜǊΩǎ ǿƛƴŘƻǿ Ŏŀƴ ōŜ ŎƻƴŘƛǘƛƻƴŀƭƭȅ ǎǳōŘƛǾƛŘŜŘ ƛnto several sections that differ in their purpose and 

functionality: 
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1. Main Menu  

2. Tool Bar  

3. Virtual Operations Bar  

4. Common Tasks Bar  

5. Explorer Bar  

6. Disk Map  

7. Legend Bar 

8. Status Bar 

A number of panels offer similar functionality with a synchronized layout. The program enables to conceal some of them 

to simplify the interface management. 

All panels are separated by vertical and horizontal expandable sliders, allowing the user to customize the screen layout. 

Main Menu  

The Main Menu provides access to the entire functionality of the program. The available functions are as listed below: 
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MENU ITEM FUNCTIONALITY 

Tools 

6ÉÅ× ,ÏÇÓȣ View logs on the carried out operations 

Send Log Files Compress and send the log to the Paragon Support Team 

&ÉÌÅ 4ÒÁÎÓÆÅÒ 7ÉÚÁÒÄȣ Transfer data from any media 

Settings... Edit the general settings of the program  

Exit  Exit the program 

Changes 

'ÅÎÅÒÁÔÅ 3ÃÒÉÐÔȣ Generate a script for the task 

3ÁÖÅ ÔÏ 3ÃÈÅÄÕÌÅÒȣ Schedule pending operations 

Undo `the last virtual 

operation`  

Cancel the last virtual operation on the List of Pending Operations 

Redo `the last virtual 

operation`  

Cancel the last undo virtual operation on the List of Pending Operations 

6ÉÅ× #ÈÁÎÇÅÓȣ Display the List of Pending Operations 

Apply Changes Launch the real execution of virtual operations 

Discard All Changes Cancel all virtual operations on the List of Pending Operations 

Reload Disk Info  Refresh the current information about disks 

Wizards  

#ÒÅÁÔÅ 0ÁÒÔÉÔÉÏÎȣ Create a partition of any file system 

&ÏÒÍÁÔ 0ÁÒÔÉÔÉÏÎȣ Format a partition of any file system 

Delete PartÉÔÉÏÎȣ Delete a partition of any file system 

5ÎÄÅÌÅÔÅ 0ÁÒÔÉÔÉÏÎÓȣ Recover an accidentally deleted partition 

-ÅÒÇÅ 0ÁÒÔÉÔÉÏÎÓȣ Merge adjacent partitions of NTFS, FAT or FAT32 file systems 

2ÅÄÉÓÔÒÉÂÕÔÅ &ÒÅÅ 3ÐÁÃÅȣ Redistribute available disk space of existed partitions 

0ς0 !ÄÊÕÓÔ /3ȣ Make your system bootable on different hardware 

0ς6 #ÏÐÙȣ Migrate a Win2K+ physical system to a virtual environment in the online mode. 

0ς6 2ÅÓÔÏÒÅȣ Migrate a Win2K+ physical system backed up with a Paragon disaster recovery 

tool to a virtual environment. 
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0ς6 !ÄÊÕÓÔȣ Recover the startup ability after unsuccessful virtualization with a 3rd party 

tool 

#ÏÐÙ (ÁÒÄ $ÉÓËȣ Create a hard disk copy 

#ÏÐÙ 0ÁÒÔÉÔÉÏÎȣ Create a partition copy 

Hard Disk  

Update MBR Update MBR (Master Boot Record) of the selected hard disk 

#ÈÁÎÇÅ 0ÒÉÍÁÒÙ 3ÌÏÔÓȣ Modify the primary partitions enumeration for the selected hard disk 

%ÄÉÔȾ6ÉÅ× 3ÅÃÔÏÒÓȣ View/edit sectors of the selected hard disk 

Connect a Virtual Disk  Connect a virtual Řƛǎƪ ǘƻ ǿƻǊƪ ǿƛǘƘ ƛǘ ŀǎ ƛŦ ƛǘΩǎ ŀ ǇƘȅǎƛŎŀƭ Řƛǎƪ 

0ÒÏÐÅÒÔÉÅÓȣ Get in-depth information on the properties of selected hard disk 

Partition  

#ÒÅÁÔÅ 0ÁÒÔÉÔÉÏÎȣ Create a partition 

&ÏÒÍÁÔ 0ÁÒÔÉÔÉÏÎȣ Format a partition 

$ÅÌÅÔÅ 0ÁÒÔÉÔÉÏÎȣ Delete a partition 

-ÏÖÅȾ2ÅÓÉÚÅȣ Move/Resize the selected partition 

#ÏÎÖÅÒÔ &ÉÌÅ 3ÙÓÔÅÍȣ Convert file system of the selected partition 

!ÓÓÉÇÎ $ÒÉÖÅ ,ÅÔÔÅÒȣ Assign drive letter to the selected partition 

2ÅÍÏÖÅ $ÒÉÖÅ ,ÅÔÔÅÒȣ Remove drive letter for the selected partition 

(ÉÄÅ 0ÁÒÔÉÔÉÏÎȣ Make the selected partition unavailable for the operating system 

5ÎÈÉÄÅ 0ÁÒÔÉÔÉÏÎȣ Make the selected partition available for the operating system 

Mark Partition as Active  Make the selected partition bootable by default 

Mark Partition as Inactive  Make the selected partition non-bootable by default 

#ÈÁÎÇÅ #ÌÕÓÔÅÒ 3ÉÚÅȣ Change cluster size of the selected partition 

#ÈÁÎÇÅ 6ÏÌÕÍÅ ,ÁÂÅÌȣ Change volume label of the selected partition 

Change Serial NumÂÅÒȣ Change serial number of the selected partition 

#ÈÁÎÇÅ 0ÁÒÔÉÔÉÏÎ )$ȣ Change identifier of the selected partition 

$Ï×ÎÇÒÁÄÅ .4&3 ÖÅÒÓÉÏÎȣ Decrease version of the selected NTFS partition 

#ÈÁÎÇÅ 3)$ȣ Change SID (Security Identifier) value of any found Windows installation 
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-ÁËÅ 0ÁÒÔÉÔÉÏÎ 0ÒÉÍÁÒÙȣ Make the selected partition Primary 

-ÁËÅ 0ÁÒÔÉÔÉÏÎ ,ÏÇÉÃÁÌȣ Make the selected partition Logical 

$ÅÆÒÁÇÍÅÎÔ 0ÁÒÔÉÔÉÏÎȣ Defragment data on the selected FAT or NTFS partition 

$ÅÆÒÁÇÍÅÎÔ -&4ȣ Defragment MFT (Master File Table) of the selected NTFS partition 

#ÏÍÐÁÃÔ -&4ȣ Shrink MFT (Master File Table) of the selected NTFS partition 

4ÅÓÔ 3ÕÒÆÁÃÅȣ Test surface of the selected partition/block of free space 

Check File System 

)ÎÔÅÇÒÉÔÙȣ 

Check the selected partition for possible file system errors 

%ÄÉÔȾ6ÉÅ× 3ÅÃÔÏÒÓȣ View/edit sectors of the selected partition 

0ÒÏÐÅÒÔÉÅÓȣ Get in-depth information on the properties of selected partition 

View 

Layouts Manage the Launcher layout with several predefined profiles 

Toolba r  Manage the Tool Bar representation: show / hide standard and navigation 

buttons, text labels and large icons 

Status Bar Display the Status Bar 

Common Tasks Bar Display the Common Tasks Bar 

Disk Map Legend Display the Disk Map legend 

Properties and Co mmands  Display the Explorer Bar 

Disk Map Location  Select whether the Disk Map will be located on the top of the main window or 

at the bottom 

Help 

Help Open the Help system (you can also do it by pressing F1) 

About  Open the dialog with information about the program 

 

 

The Main Menu contents available at the moment may vary depending on the selected 

object. 

Tool Bar  

The Toolbar provides fast access to the most frequently used operations: 

BUTTON FUNCTIONALITY 



13 

/ƻǇȅǊƛƎƘǘϭ мффп-2009 Paragon Software Group. All rights reserved. 

 

Connect a virtual disk 

 

Open the Help system 

Virtual Operations Bar  

The program supports previewing the resulting layout of hard disks before actually executing operations (so-called 

virtual mode of execution). In fact, when the virtual mode is enabled, the program does not accomplish operations 

immediately, but places them on the List of Pending Operations for later execution. 

The Virtual Operations Bar enables to manage pending operations. 

BUTTON FUNCTIONALITY 

 
Cancel the last virtual operation on the List of Pending Operations 

 
Cancel the last undo virtual operation on the List of Pending 

Operations 

 
Display the List of Pending Operations 

 
Launch the real execution of virtual operations 

 
Cancel all virtual operations on the List of Pending Operations 

 

 

Virtual mode is an effective way of protection from any troubles, since no operations will 

be executed until clicking the Apply button for confirmation, thus giving a second chance to 

weigh all pros and cons of this or that particular operation. The program politely reminds 

the user that there are unsaved changes by showing the following window: 

 

Common Tasks Bar 

The Common Tasks Bar is located on the left side of the main window. It is intended for easy access to the program's 

wizards. 

The bar contains several tabs named Virtualization Tasks, Copy Tasks, Tools and News and Documentation. Each of 

these contains a separate button bar which can be folded by clicking it. 

Virtualization Tasks 
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Starting the P2V Copy Wizard to migrate a Win2K+ physical system to a virtual 

environment in the online mode. 

 
Starting the P2V Restore Wizard to migrate a Win2K+ physical system backed up 

with a Paragon disaster recovery tool to a virtual environment. 

 
Starting the P2V Adjust OS Wizard to recover the startup ability after unsuccessful 

virtualization with a 3rd party tool. 

Copy Tasks 

 
Starting the Copy Hard Disk Wizard to copy a hard disk. 

 
Starting the Copy Partition Wizard to copy a partition. 

Tools 

 
Starting the Connect a Virtual Disk dialog to connect a virtual disk to work with it 

ŀǎ ƛŦ ƛǘΩǎ ŀ ǇƘȅǎƛŎŀƭ ŘƛǎƪΦ 

 
Starting the File Transfer Wizard to transfer data from any media. Besides it 

provides access to Paragon backups as regular folders to browse through their 

contents or copy required files. 

News and Documentation 

 

Launching the help system (you can also do it by pressing F1). 

 
Opening the page which contains information about the program. This page will 

be displayed in the Explorer Bar. 

 
Opening a brief review on the Paragon Scripting Language. 

Disk Map 

The Disk Map is displayed in the Explorer Bar when the Disk View tab is selected. It is located either at the top or at the 

bottom of the window, depending on the state of the Disk Map Location option (Main Menu: View > Disk Map 

Location). 

As the name infers, the Disk Map displays the layout of physical and logical disks. Physical disks are represented with 

rectangle bars that contain small-sized bars. These small-sized bars represent logical disks. Their color depends on the 

file system of the appropriate partition. 

 

Large-sized bars display the following information about physical disks: 
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¶ Manufacturer, 

¶ Model. 

Small-sized bars display the following information about logical disks: 

¶ Serial number, 

¶ Drive letter, 

¶ Total size, 

¶ File system. 

CǳǊǘƘŜǊƳƻǊŜΣ ƛǘ ƛǎ ǇƻǎǎƛōƭŜ ǘƻ ŜǎǘƛƳŀǘŜ ǘƘŜ ǳǎŜŘ Řƛǎƪ ǎǇŀŎŜ ōȅ ƭƻƻƪƛƴƎ ŀǘ ǘƘŜ ǎƛȊŜ ƻŦ ǘƘŜ ōŀǊΩǎ ǎƘŀŘŜŘ ŀǊŜŀΦ ¢ƘŜ ǇǊƻƎǊŀƳ 

offers to choose from several types of thŜ Řƛǎƪ ƭŀȅƻǳǘ ǎŎŀƭƛƴƎΦ LǘΩǎ ŘƻƴŜ ŜǎǇŜŎƛŀƭƭȅ ǘƻ ƛƴŎǊŜŀǎŜ ǘƘŜ ǇǊƻƎǊŀƳ ǳǎŀōƛƭƛǘȅΦ CƻǊ 

ƛƴǎǘŀƴŎŜΣ ƛŦ ȅƻǳΩǾŜ Ǝƻǘ ŀ ƘƛƎƘ ŎŀǇŀŎƛǘȅ ƘŀǊŘ ŘǊƛǾŜ ŎƻƴǘŀƛƴƛƴƎ ōƻǘƘ ǾŜǊȅ ƭŀǊƎŜ όƳƻǊŜ ǘƘŀƴ млл D.ύ ŀƴŘ ǊŀǘƘŜǊ ǎƳŀƭƭ όƭŜǎǎ 

than 10 GB) partitions, you can select the logarithmic type to make all partitions readable, otherwise (selecting the 

ƭƛƴŜŀǊ ǘȅǇŜύ ȅƻǳ ǿƻƴΩǘ ōŜ ŀōƭŜ ǘƻ ǎŜŜ ǎƳŀƭƭ ǇŀǊǘƛǘƛƻƴǎ ŀǘ ŀƭƭΣ ōǳǘ ǘƘƛƴƎ ǎǘǊƛǇǎΦ hƴ ǘƘŜ ƻǘƘŜǊ ƘŀƴŘΣ ƛŦ ǘƘŜ ǇǊƻǇƻǊǘƛƻƴŀƭ Řƛǎƪ 

layout is critical for you, the linear type is exactly what you need.  

bŜǾŜǊǘƘŜƭŜǎǎ ǘƘŜǊŜΩǎ ŀ ŎƻƳǇǊƻƳƛǎŜ ǎƻƭǳǘƛƻƴ ς linear scaling with the minimal limit to small partitions. So if a partition is 

too small it will remain readable. 

Just click on the arrow icon on the top right side of the Disk Map to select the desired scaling type. 

 

Disk Map is synchronized with the Explorer Bar. Thus by selecting a disk on the Disk Map, the Explorer Bar will 

automatically display detailed information on it. 

 

The drag-and-drop functionality is not available when the logarithmic type of the disk 

layout is selected. 

Explorer Bar  

The Explorer Bar is located in the center of the main window which emphasizes its importance. The bar displays 

reference information including: 

¶ The help system; 

¶ General information on the product including its name, version and a list of helpful links; 

¶ Detailed information about disks selected on the Disk Map; 

¶ List of scheduled operations; 

¶ List of scripts; 
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¶ Volume Explorer utility; 

¶ Disk Editor utility. 

According to these categories the Explorer Bar has several tabs: 

¶ Disk View, which offers the user the following options: 

- Partition List to get a clear-cut picture of the current state of the system hard disks/partitions; 

- Disk Editor to view/edit sectors of the selected partition/hard disk; 

- Volume Explorer to browse and export contents of the selected partition/hard disk; 

- Properties to view detailed information on the selected partition/hard disk in the bright graphical form. 

 

You can switch between these components by clicking tabs on the left side of the Explorer 

Bar. 

¶ Scheduled Tasks, which gives the user the possibility of browsing and editing scheduled operations and the 

program scripts. 

¶ Help, which contains the program help and general information on the product. 

You can access the desired information by clicking on the appropriate tab. 

The Explorer Bar is a fully-functional embedded HTML browser, which offers the possibility to address, for example, the 

company's website to look through important technical notes or download the latest updates without having to close 

the program.  

The program help is also HTML-oriented. You can read it and follow external links from to get additional information. 

 

To easily navigate through browsed pages, the program provides the following functionality: 
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BUTTON FUNCTIONALITY 

 
Return to the previously browsed 

page 

 
Open the next browsed page 

 
Stop loading the current page 

 
Refresh the contents of the current 

page 

 

Partition List  

The Partition List is another helpful tool that enables you to get a clear-cut picture of the current state of the system 

hard disks/partitions. Partitions are sorted according to their starting position. For every item of the list there is the 

possibility to call the context-sensitive popup menu with available operations. Besides, the program provides detailed 

information on all hard disks/partitions found in the system including the following properties: 

   - Name, 

   - Volume label (if exists), 

   - Partition type (Primary/Extended /Logical), 

   - File system type, 

   - Size, 

   - Amount of used and unused (free) space, 

   - Start/End cylinder, 

   - Start/End head, 

   - Start/End sector, 

   - Free size in sectors/bytes, 

   - Active/Inactive attribute, 

   - Hidden/Unhidden attribute. 

Legend Bar 

The Legend Bar explains the color scheme used for disk and partition presentation. You can hide (or show) the bar with 

the appropriate Main Menu item: View > Disk Map Legend. When it is activated it can be found at the bottom of the 

Explorer Bar.  

The program distinguishes between the following types of known file systems: 

   - FAT16/32, 
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   - NTFS, 

   - Linux Ext2/3/4, 

   - Linux ReiserFS, 

   - Apple HFS. 

Status Bar 

This is the bottom part of the main window. The Status Bar displays menu hints, for each item the cursor points to. 

The user can hide (or show) the bar with the appropriate Main Menu item: View > Status Bar. 

Settings Overview  
The Settings dialog is available from the Main Menu: Tools > Settings. All the settings are grouped into several sections, 

which functions are described in the following paragraphs. The list of sections is placed on the left side of the dialog. By 

selecting a section from the list, you can open a set of options. 


  

To get a detailed description to any setting, control, or field of the program just click the 

hint button and then the object you need. 

General Options  

 

This section contains a set of general options that will be taken into account during any operation carried out with the 

program: 

¶ Enable data loss protection. Mark the checkbox to make the program work in the fail-safe mode (also referred 

to as the data-loss protection mode), which ensures reliability for operations by maintaining a special journal. In 



19 

/ƻǇȅǊƛƎƘǘϭ мффп-2009 Paragon Software Group. All rights reserved. 

case of a hardware malfunction, power outage or an OS failure happened in the middle of a data-sensitive 

operation (resize, move, merge, redistribute, change cluster size, etc.), the program will ask to insert the 

bootable recovery media and automatically complete the interrupted operation, thus reviving the corrupted 

partition. 

 
It is strongly recommended to enable this option. 

Partitioning Options  

 

This section contains a set of options that will be taken into account during partitioning operations: 

¶ Enable 64 KB cluster size for FAT16. Mark the checkbox to enable 64KB clusters for FAT16 partitions. Thus you 

will be able to create FAT16 partitions up to 4GB in size 

 

Due to the maximum cluster size of 32KB for Windows 95/98/ME or MS DOS, FAT16 

partitions larger than 2GB are not reliably accessible under these operating systems. 

¶ Request confirmation before partition deletion. Mark the checkbox to activate an additional security 

mechanism. Thus when going to delete a partition you will be automatically requested to enter its label. 

¶ Request confirmation when converting FAT16 to FAT32. Mark the checkbox to automatically request 

confirmation before converting FAT16 to FAT32. There are a number of situations when this kind of conversion 

is the only way out to accomplish the operation. For instance, you are going to migrate your system to a larger 

hard disk with the proportional resize of existing partitions, what is very convenient. As a result you can get 

original FAT16 partitions go beyond the 4GB limit. Thus without conversion to FAT32, this operation will in no 
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way be possible to accomplish. The same goes for any copy hard disk/partition or restore hard disk/partition 

operation involving an extra upsizing. 

General Copy and Backup Options  

 

This section contains a set of options that will be taken into account during copy and backup operations: 

¶ HDD raw processing. Mark the checkbox to copy/back up a hard disk in the sector-by-sector mode, thus 

ignoring its information structure (e.g. unallocated space or unused sectors of existing partitions will be 

processed as well). This can help to avoid problems with hidden data created by certain applications or the 

system administrator. However, it will take more time to accomplish the operation. 

¶ Partition raw processing. Mark the checkbox to copy a partition in the sector-by-sector mode to successfully 

process unknown file systems. However it is not recommended to enable this option when working with 

supported file systems as it takes more time to accomplish the operation. 

¶ Skip OS auxiliary files. Mark the checkbox to skip OS auxiliary files (like pagefile.sys, hiberfil.sys, etc.), thus 

reducing the operation time and the resulted size of the backup image. 

Hot Processing Options  
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In this section you may configure the hot processing mode: 

¶ Enable hot processing. Mark the checkbox to enable the so called hot data processing mode that is specially 

designed to process data without restarting your operating system. 

¶ Hot processing technology. From the pull-down list you can select the required hot processing technology. 

¶ Always use hot processing. Select the option to process partitions without making them locked. Thus you will 

be able to keep working with them as usual. 

¶ Use hot processing only when partition is locked. Select the option to use the hot processing only when 

partitions are locked and cannot be processed without restarting the computer. Please keep in mind, that once 

you start any operation on a partition in this mode, it will automatically be locked by the program, thus you 

won't be able to keep working with it as usual. 

¶ Hot processing temporary drive. Here you can select a disk drive that will be used to store the temporary hot 

backup data (by default ς C:). 

¶ Attempts to start VSS. Here you can set how many attempts to start Microsoft VSS the program is to do before 

automatically rebooting the system and accomplishing the operation in a special boot-up mode. 

¶ Timeout between attempts (in seconds). Here you can set a time period between different attempts to start 

Microsoft VSS. 

¶ Switch between hot processing technologies. Mark the checkbox to automatically switch between Paragon Hot 

Processing and Microsoft VSS if one of them is unavailable at the moment. 






























































